
The ultimate goal for this course is to have each student understand 
the complexities and possibilities of digital photography. 

RTV 2773 
Multimedia Practicum: Digital Photography 

Summer 2013 Course Information 
 
Professor: John C. Dailey, Ph.D. 
 WH 121  
E-Mail: jdailey@ozarks.edu  
Photo Gallery: http://www.cybrdr.com/details/ 
Office Phone: 479-979-1352 
Off Campus Phone:  479-774-4359 
Classroom / Class Time:  WH 210, MTWRF, 9:30 am - 12:00 pm 
 
Course Description: 
 An introduction to the fundamentals of digital photography through both in camera and post 
 production techniques.  Recent innovations like High Dynamic Range photography, color 
 enhancement, and low light imagining will be explored.    
 
 NOTE: Students will need to provide their own Digital Still Camera (e.g, a simple Point-N-Shoot or 
 DSLR camera) to participate in this class. 
 
Required Account:  http://picasaweb.google.com/ 
 
Suggested Text: 
 Freeman, M.  (2007).  The Photographer's Eye: Composition and Design for Better Digital Photos  
  Focal Press.  ISBN: 978-0240809342 
 
Expectations: 

Deadlines - All projects will be submitted at the start of class on the due date.  Late submissions 
will not receive full credit. Students who fail to submit all required projects will not receive a passing 
grade in the course.  Since an important part of work in media fields is meeting deadlines, late work 
will not be accepted unless you contact me in advance with a legitimate, documented reason (for 
example, serious illness would be an acceptable excuse; having work due in another class would 
not).  Time management is an important skill for success in the communication field. 

 
Attendance - I expect you to be in class on time.  Excessive absences will result in the lowering of 
your grade. Because illness, emergency, or University-sanctioned activities can sometimes cause 
you to miss class, absences may be excused if you discuss the problem (in advance if possible) 
with the instructor.  If you cannot reach me, leave a message with the division office (979-1233).  
The decision about whether or not to excuse an absence rests with the instructor.  Excessive 
absences (more than three) will result in an academic alert.  
 
Academic Integrity - I expect you to do your own work for this class.  You may consult with others 
and you may refer to models or examples from the texts or class, but you must individually prepare 
and create your own work for grading.  For more information, refer to the section on academic 
integrity in the Talon student handbook. Violations of academic integrity are serious offenses.  If you 
are caught using someone else’s work as you own or helping someone else to cheat, you may 
receive a zero for that assignment and I will notify the Provost and the BCG division chair.  If you 
are caught plagiarizing or cheating a second time, you will receive a grade of “F” for the course and 
I will notify the Provost. 
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Grading Policies: 
 Evaluation Criteria: Each of the 6 photography assignments will count as 15% of your grade, for 
 a total of 90%. The remaining 10% is for attendance, participation in class, and the completion and 
 quality of your peer reviews.  
 
 Late assignments: Since the assignments come in rapid succession, it is important that each be 
 completed on time. Replacing photos after the deadline is not allowed, and will be treated as a 
 violation of the honor code. To allow for unforeseeable circumstances, you will be allowed 2  days 
 (24 hour periods) of grace across all your assignments. Beyond this, late assignments will be 
 penalized by 20% of the grade for that assignment per day that they are late. Additionally, any 
 assignment that is not submitted within one day of the assignment deadline will not be peer 
 reviewed. Exceptions to this late policy will be made only in the case of a necessary (non-pleasure) 
 trip approved in advance by the professor, or severe illness. If you do not submit one of the 
 assignments at all, or miss more than two reviews, you will fail the course. In this case, or if you 
 believe you are in danger of failing, it is your responsibility to come talk to me ASAP. Incompletes 
 are given only in exceptional circumstances. 
 
 Originality, collaboration, and borrowing: Many of you may have taken extraordinary 
 photographs in your life. Some of these photographs may perfectly and beautifully satisfy the 
 requirements of a class assignment. Nevertheless, in the interests of fairness and continued 
 learning, I expect your submissions for each assignment to be photographs taken by you  
     specifically for this course. You are encouraged to discuss assignments with friends, but you are 
 expected to take your own photographs. 
 
ADA STATEMENT 

If any member of the class has a documented disability and needs special accommodations, the 
instructor will work with the student and the office of Student Support Services or the Jones 
Learning Center or the Academic Center for Excellence to provide reasonable accommodation to 
ensure the student a fair opportunity to perform in this class.  In order to plan for optimum success, 
please advise the instructor of the disability and the desired accommodations as soon as possible. 
Students are strongly encouraged to notify the instructor during the first week of classes. Without 
ample planning / preparation time, we cannot assure the availability of needed accommodations in 
a timely manner. 
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QUALITATIVE EVALUATION CRITERIA 

Note: Your final grade in this course is determined by overall performance. 
The following components will be weighted to determine your final grade: 

 
Assignments / Reviews:        Percent  
Bad Photos (due 5/15) 15.0 
Portraiture (due 5/20)  15.0 
Macro (due 5/22) 15.0 
Architecture & Interiors (due 5/24) 15.0 
Landscape and Nature (due 5/28)        15.0  
Night and Color (due 5/31)         15.0 
 
Discussion / Participation:     
In-Class Discussion  10.0 
 
TOTAL                                                100% 
 
A = 90-100% D = 60-69% 
B = 80-89% F = Below 60% 
C = 70-79% 

 
COURSE SCHEDULE  (may be amended as needed to benefit the class) 
 

 Date Topic Activity / Discussion / Presentations 
 Week 1   
  May 13 

 May 14 
 May 15
 
 May 16 
  
 May 17 

Assignment 1 - Bad Photos  
Getting To Know Your Camera 
Composition 
 
Photoshop 
 
Assignment 2 - Portraits & Light 

Introduction to course / cameras / Picasa 
 
Assignment 1 - SHOW & TELL  
Between The Pixels 
PS - Interface, Menus, Tools, Selections  
PS - Layers, Filters, Effects 
3 Point Lighting 

  
Week 2 

  

  May 20 
 May 21 
 May 22 
 May 23 
 
 May 24 

Workday 
Assignment 3 - Macro 
Workday 
Assignment 4 - Architecture & Interiors 
 
Workday 

Assignment 2 - SHOW & TELL - 10:15 AM 
O of U Up-Close 
Assignment 3 - SHOW & TELL - 10:15 AM 
O of U Widescreen 
PS - Panoramas 
Assignment 4 - SHOW & TELL - 10:15 AM 

  
Week 3 

  

  May 27 
 May 28 
 May 29 
 May 30 
 May 31 

MEMORIAL DAY 
Assignment 5 - Landscape and Nature 
Workday 
Assignment 6 - Night and Color  
Workday 

NO CLASS 
FIELD TRIP 
Assignment 5 - SHOW & TELL - 10:15 AM 
Intro to HDR & Low Light  
Assignment 6 - SHOW & TELL - 10:15 AM 
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Assignment 1 - Bad Photos                           

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Motivation 
 
Cameras in automatic mode try to take care of the technical aspect of photography for you, and just let 
you frame the scene and shoot.  They will attempt to make sure the scene is not too dark, not too 
bright, not blurry, and so on.  These goals don't always match up with the photographer's intent.  For 
this first assignment, you'll be playing with the settings on your camera to produce photos you can't 
easily produce in automatic mode.  You'll be taking photos that your camera might consider "bad" in 
some technical way, but are nonetheless interesting to look at, and even artistic.  For this assignment, 
you'll also be setting up the online photo album that you'll use throughout the course to both submit 
your work for grading, and to share your work with your fellow students. 
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Instructions 
1. Make a Picasa Web account for the course.  You'll be making one new album in this account for 

each assignment.  If you already have a Google login you can use that, or you can make a new 
one just for RTV 2773.  Picasa web ties in with the Picasa photo management software, which 
you might find useful for managing your photo collection.  Making a Picasa Web gallery is fairly 
straight-forward. If you're having trouble, talk to me after class and I’ll help you get started. 

2. The Picasa albums you make for this course should all be listed as "public" so myself and your 
fellow students can see the photos you've taken.  If you have a particular reason to make an 
album not public, coordinate with me to make sure I can still grade it. 

3. Email the web address of your Picasa account to me. 
 
Take some photos that meet the requirements listed below, and upload them as an album titled  
"RTV2773 Assignment 1 - Bad Photos", and add comments below each photo explaining how you 
took the photo, what relevant camera settings you used and why, any image processing done to the 
photograph afterwards, and most importantly, which requirements each photo covers. See the example 
solution below as a guide to what I’m looking for. Your comments aren't required to go into quite as 
much detail as the example solutions, but if you don't add comments to your photos you won't receive 
any credit for the assignment. 
 
Each photograph you upload should meet one or more of the requirements below, and you 
should make sure to cover every requirement with at least one photo. In other words, for each 
photo you upload, it should fulfill at least one requirement for the assignment, and among all of the 
photos you upload, every requirement should be fulfilled at least once. You should upload at least 5 
photographs for the assignment, but no more than 15 please.  Be sure to state in your comments 
(ideally right at the top) which requirements each photo meets. Note that these general rules apply to 
this assignment and all subsequent photo assignments in this course. 
 
Now, for Assignment 1 specifically: remember, even though the photos you take are supposed to be 
technically "bad" in some sense, I want you to create things that are interesting to look at. The 
"badness" should be intentional for an artistic purpose. 
 

 Requirement 1: At least one photo must be poorly exposed. That is, most of the image should 
be either very close to black (underexposed) or close to flat white to due oversaturation 
(overexposed).  

 Requirement 2: The main subject of at least one photograph should be motion-blurred, either 
due to movement of the subject or movement of the camera. 

 Requirement 3: In at least one photo, nothing at all should be in focus. It's hard to take a good 
looking photo where nothing is in focus - be creative!  

 Requirement 4: You should use the wrong white balance setting for some intentional effect in 
at least one photo. The white balance setting on a camera tells the camera what color it should 
expect the scene illumination to be, for example daylight (which is bluish) or indoor 
incandescent (which is reddish). Most cameras have an "auto white balance (AWB)" setting, 
and manual settings for these other illumination types. You don't need to understand white 
balance in detail to fulfill this requirement. It's a subject we'll cover in detail later in the course.  

 Requirement 5: At least one photo should be poorly composed. Search on Google for "rules of 
composition". Read about them, and then intentionally break a few. If you're not sure what to do 
you may want to consider an exactly centered subject that produces an oddly symmetric photo, 
a confusion between the subject and a background object, or a horizon that isn't level. 
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FAQs  
 
Q: My Camera doesn't have manual focus. How can I force everything to be out of focus? 
A: Even if your camera doesn't provide manual focus, you can usually force the focus to be anything 
you want. Just point at an object that's not in your scene but at the desired depth, press the shutter 
button halfway to autofocus on it, then with the button still half-pressed, swing around to aim at your 
scene and press the button fully. Does the exposure come out wrong when you do this? We'll talk in 
class about focus-lock and exposure-lock functions, which not all cameras have. 
 
Q: At what resolution should I upload my photos? 
A: Google resizes your photos for viewing, and gives you 1GB of free storage. This should be enough 
that you can safely upload full resolution images for the course. If you're worried about running out of 
space, you could also resize your images in Photoshop, Picasa, or a similar program before upload to 
something smaller. 
 
Q: Are we allowed to edit our photos in Photoshop before uploading? How much editing is acceptable? 
Do we have to say what we did? 
A: In general, most requirements won't necessitate any image manipulation in Photoshop, and for this 
first assignment, none of them do. However, some requirements for future assignments will specifically 
involve image editing, and even for those that don't, you're always welcome to process your images in 
Photoshop or any other program. Just keep in mind that if you do edit your photos in Photoshop, you 
should definitely state what you did in the Picasa comments. For example, you might say: "I used 
Photoshop to increase the saturation and darken the sky". Finally, keep in mind that Photoshop should 
not be used as a substitute for proper use of your camera or for faking a requirement. For example, for 
this assignment your underexposed or overexposed photo must be that way from the camera -- you're 
not supposed to just take a normal photo and use Photoshop to make it way darker or brighter. 
 
Grading 
 
It's hard to judge artistic quality, so rather than grading the individual photos, I will assign grades based 
on whether you met the requirements of the assignment.  For each requirement, you'll be given 3 
points for meeting the requirement, check-minus for not quite meeting the requirement, or 
check-plus if you do something spectacular that makes your professor’s jaw drop. 
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Assignment 2 - Portraits & Light   

                         

 
Motivation 
 
People are certainly one of the most interesting and most challenging subjects to photograph.  You will 
need to think about lighting, backgrounds, depth of field, composition, and color. You can also 
(tastefully) touch up each photo in Photoshop. 
 
If you find yourself without anyone willing to model for you this week, you can take a self-portrait for any 
of the requirements. This is an interesting type of photograph in its own right, and adds a degree of 
difficulty. 
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Instructions 
 
This assignment has four photographic requirements.  Requirements 1 through 3 must be met by taking 
pictures of human beings. (Sorry, no portraits of pets, stuffed animals, etc.)  Requirement 4 can be met 
using any subject of your choosing.  You should upload at least 4 photographs for the assignment, 
but no more than 12 please.   
 
Requirements 
 

 Requirement 1: Indoor Traditional Portrait 
 Take a portrait of someone using a traditional portrait lighting setup as demonstrated in class (a 
 key light, a fill light, and possibly a background light and accent/rim light).  Unless you have 
 some fancy lighting gear of your own, you should take this picture during class where we will 
 set up a full studio lighting kit. 
 Requirement 2: Indoor Natural Light Portrait  

Take a portrait of someone indoors using only non-electric sources of light (a fireplace, candles, 
the sun, etc). You might want to arrange someone near a window. Think about the light in the 
same way as for the studio lighting, and comment on how you created a fill light, how you 
created a key light, etc.  

 Requirement 3: Outdoor Available Light Portrait  
Take a portrait of someone outdoors under available lighting only. Comment on what serves as 
the fill light and key light. If you like, you can also make this one a candid shot, in which the 
subject is not aware you're taking a photo (or at least appears to not be aware).  

 Requirement 4: Flash + Ambient  
Take a portrait that uses a combination of your camera's flash and ambient illumination. Again, 
comment on what serves as the key light and what serves as the fill light. Remember, you need 
not point the flash right at the subject - with a small hand-held mirror or white card you can 
bounce any camera's flash elsewhere.  

 
Upload your photos and add comments. 

 
Upload your photos using the Picasa account you created in the first assignment to a public Picasa 
album titled "RTV2773 Assignment 1 - Portraiture". Write at least two short paragraphs (ie two 
Picasa comments) below each of your photos explaining how you arranged the scene, how you 
took the photo, what relevant camera settings you used and why, any image processing done to the 
photograph afterwards, and most importantly, which requirement the photo covers. 
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Assignment 3 - Macro   

                         

 
Motivation 
 
Humans have excellent vision compared to the majority of the animal kingdom; yet modern 
photographic lenses and sensors are better still.  A nice lens will have a larger aperture than the pupil in 
your eye making it easier to isolate the subject and blur out everything else.  Also, lenses are available 
with much longer focal lengths than the human eye allowing us to magnify a subject beyond our natural 
ability to see it.  It's a real pleasure to take a photograph that lets us see that which we normally could 
not. 
 
Instructions 
 
In this assignment you'll be turning your gaze downward at flowers, bugs and other small, interesting 
things you might normally ignore.  Take 5 to 10 photographs for this assignment.  You may hit 
multiple requirements using a single photo. For each photograph, the subject should be something 
small and close to the camera. You may enjoy photographing bugs, flowers, small pieces of trash, 
electronics, mundane household objects that you wouldn't normally look at closely, parts of the body 
(please don't take any photographs your instructor is not going to want to grade), toys, leaves, water 
droplets, gemstones, and food, among other things. Pay attention both to the subject that is in focus, 
and also to the quality of the out-of-focus regions. 
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Requirements 
 

 Requirement 1: Focus on the foreground  
At least one of your photographs should be be focused on the closest thing in the field of view to 
the camera, and should contain out-of-focus elements behind it.  

 Requirement 2: Focus on the mid-ground.   
At least one of your photographs should have out-of-focus elements in front of and behind the 
subject you are focused on.  

 Requirement 3: Bugs. 
At least one of your photographs should have a bug as its main subject. If you can't find a bug, 
other very small animals are just fine, too.  Keep it really small, though (dogs and cats are way 
too big, but little lizards could work).  

 Requirement 4: Plants. 
Take at least one photograph whose subject is part of a plant - e.g. a flower, leaf, spine, some 
bark, a piece of fruit.  

 Requirement 5: Man-made objects. 
At least one of your photographs should feature a man-made object like a toy, some circuitry, 
jewelry, etc.  
 

 
Upload your photos and add comments. 

 
Upload your photos using the Picasa account you created in the first assignment to a public Picasa 
album titled "RTV2773 Assignment 3 - Macro". Write at least two short paragraphs (i.e., two Picasa 
comments) below each of your photos explaining how you arranged the scene, how you took the 
photo, and what relevant camera settings you used and why, any image processing done to the 
photograph afterwards, and most importantly, which requirement the photo covers. 
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Assignment 4 - 
Architecture and 
Interiors   
Motivation 
Good photography often shows us the 
familiar in an unfamiliar way. Taking 
macro photographs in the last 
assignment, we made small things 
larger on our computer screens, and 
saw a level of detail not usually visible to 
the naked eye. For this reason, it's not 
too difficult to take a macro photograph 
that makes a non-photographer gasp. 
Capturing a compelling image of 
Architecture can be much harder. This 
time you'll be looking at the spaces 
where people live and work and trying to 
fit them into a frame. 
 
Architecture is typically more geometric 
than natural scenes, so this assignment 
is a good reason to think about the 
geometry of your scene. Consider 
repeating elements, size relationships 
as they change under perspective, the 
lines induced by vanishing points, and 
the texture and weathering of man-

made objects. One way to surprise people with architecture and interior photography is by using clever 
composition to highlight the geometric aspects of structures that are subliminal or even overlooked. The 
requirements this week will help you play with geometry and think about the practical concerns of 
people who need to represent an interior space in a photograph. 
 
Instructions 
 

There are 5 requirements in this assignment that you should meet by taking 5-10 
photographs. 
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Requirements 
 

 Requirement 1: Vertical vanishing point in at least one of your photos, vertical lines in the 
world (e.g. corners of buildings) must visibly converge to a vanishing point either within or nearly 
within your frame. To do this, look up and use a wide field of view (a short focal length).  

 Requirement 2: No vertical vanishing point in at least one of your photos, vertical lines in 
the world must appear parallel in your photograph. You can do this by looking straight ahead 
when you take the picture and fixing the composition by cropping later. Alternatively, you can 
use Photoshop's perspective warp tool (found under Edit->Transform->Perspective) to make 
these lines parallel. You can also use the lens correction tool found in the Filter->Distort menu.  

 Requirement 3: Frame your shot… At least one of your photos should be shot through a door, 
window, archway, or other physical man-made frame. The frame should be visible in the 
photograph, but is not necessarily the subject. The frame need not be rectangular.  

 Requirement 4: Repeating patterns.  Find some interesting repeating patterns in a building or 
other man-made architectural object and use them as the focus of a photograph. Try to be 
creative here -- don't just take a random photo that happens to have some repeating elements. 
Instead, make the repeating elements the obvious theme of the image. So while you should 
certainly explain your choices in your comments, the repeating patterns shouldn't be so obscure 
that the viewer would need to read your comments in order to ascertain the repeating theme of 
the photo.  

 Requirement 5: Interior Panorama.  As real-estate agents know, it's hard to capture the 
interior of a room without making it look small, and it's usually impossible to fit the entire room in 
the frame (where would you stand?). We're going to solve this with an interior panorama. Stand 
in the corner of a small room, or at the center of a large room, and take a sequence of 
photographs that captures the entire room, rotating the camera about its center of perspective 
(somewhere in the middle of the lens). Make sure your photographs overlap by about 25-50%. 
Then, convert your set of photographs into a single panorama that better shows off the interior 
of the room. We want to see the panorama, not the source photographs. Try to find an 
interesting room to do this in. Interiors are often dim, so pay attention to your camera settings 
and the available light.  In Photoshop you can make a panorama by going to the File menu, 
selecting Automate, and then Photomerge. A cylindrical layout usually works best, but you 
should try the other ones too to see what they do. If the resulting image has obvious artifacts 
(eg edges that don't line up), you probably didn't rotate the camera about the center of 
perspective, and need to try again. For this reason, you may want to make multiple attempts at 
capturing the source photos for the panorama before you take your photos back to Photoshop.  

 
Upload your photos and add comments. 
 
Upload your photos using the Picasa account you created in the first assignment to a public Picasa 
album titled "RTV2773 Assignment 4 - Architecture and Interiors ". Write at least two short 
paragraphs (i.e., two Picasa comments) below each of your photos explaining how you arranged 
the scene, how you took the photo, and what relevant camera settings you used and why, any 
image processing done to the photograph afterwards, and most importantly, which requirement the 
photo covers. 

. 
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Assignment 5 - Landscape and Nature   

 
 
 
Motivation 
 
We explored the man-made environment in assignment 4.  It's time to return to one of the richest 
sources of beauty for photography: nature, and particularly the natural landscape.  The difference 
between a mundane landscape and a great landscape is often composition.  Pay attention to lines, 
framing, suggestive forms, diagonals, s-curves, balance, rhythm and texture.  Lighting will also play a 
large role in your photographs this week.  You will find that morning and evening lighting brings out rich 
colors and delicate shadows in your photographic subjects, whereas mid-day lighting is generally harsh 
and direct.  For a more dramatic photograph try positioning yourself so that the sun provides side-
lighting, or even back-lighting.  Getting the correct exposure is more challenging in these situations, but 
the results are well worth it! 
 
Instructions   
 
There are 4 requirements that you will meet by taking 4-8 photographs. Below each one justify 
your choice of camera settings and comment on compositional elements of your scene. 
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Requirements 
 

 Requirement 1: Use an S-Curve 
S-Curves can be used in photographs for a variety of purposes. They can lead the viewer's eye 
to the subject, convey a sense of depth (e.g., a road winding into the distance), or they can be 
flat compositional elements that create a balanced scene. At least one of your photos this week 
should use an S-Curve for one of these purposes. Describe in the comments what purpose the 
S-curve serves compositionally. Note that the S-curve we refer to here is not the same thing as 
an S-curve you might use in a curves layer in Photoshop to enhance contrast. 

 
 Requirement 2: Panorama 

In assignment 4 you took an interior panorama, and had to be very careful to rotate the camera 
about the center of the lens to avoid artifacts. This week take an exterior panorama of a 
landscape. You'll find that landscape panoramas are far more forgiving; as the scene is mostly 
far away so small movements of the photographer do not materially change the point of view. 
It's easy to make a boring landscape panorama that simply compresses multiple elements into 
the frame. Find a subject wide enough to justify the use of this technique. 

 
 Requirement 3: Texture 

Take at least one shot in which the main, or even sole compositional element is a natural 
texture. Use a small aperture (large F-number) to get everything in focus. Interesting natural 
textures include grass, rock, pebbles, and clouds. Use Photoshop to take advantage of the full 
tonal range available to you, from black to white. You'll find that textures under grazing light 
appear richer, which leads us to the next requirement... 

 
 Requirement 4: The Golden Hour 

Landscape photography is best done in the golden hour. This is the hour after dawn or the hour 
before sunset when the light is a rich golden color and strikes the earth at a grazing angle, 
emphasizing details. At least one of your photographs for this assignment must be of a 
landscape taken during the golden hour. Dawn is definitely preferable, as the air is much 
clearer, but if your sleep schedule makes dawn either too late or too early, sunset is also 
acceptable. Sunset is currently approximately 8:20pm, and dawn is approximately 6am. You 
should thus be planning to take photos from 7:15-8:15pm, or 6-7am. 

 
Upload your photos and add comments. 
 
Upload your photos using the Picasa account you created in the first assignment to a public Picasa 
album titled "RTV2773 Assignment 5 - Landscape and Nature". Write at least two short paragraphs 
(i.e., two Picasa comments) below each of your photos explaining how you arranged the scene, 
how you took the photo, and what relevant camera settings you used and why, any image 
processing done to the photograph afterwards, and most importantly, which requirement the photo 
covers. 

. 
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Assignment 6 - Night and Color   

 
 
 
Motivation 
 
Taking photographs at night presents unique challenges. Exposure times must be very long, so hand-
holding the camera is out of the question. However, with a steady place to rest the camera (which need 
not be a tripod), and a long exposure, the light gathering ability of your camera can greatly exceed the 
human eye, allowing you to capture a shot of something you could not normally see, such as a forest at 
night, a faraway galaxy, or even a rainbow cast by moonlight.  
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Instructions   
 
There are 3 requirements that you will meet by taking 12-20 photographs.  
NOTE: Requirement 3 (HDR) will take extra time, so please review it ASAP. 
 

 Requirement 1: An Outdoor Night Scene of Nature 
Head outside, find somewhere stable to rest your camera, and photograph a picturesque natural 
night scene. We want to see absolutely no motion blur due to camera movement in your shot. 
You may wish to use the self-timer mode on your camera to avoid the problem of moving the 
camera when you press the shutter button. As this is a night scene, your exposure time should 
be at least one or two seconds. For this nature requirement, you may want to find a landscape 
illuminated by the sky and/or moon and/or artificial lights, but the subject should be nature (and 
not artificial objects). It's okay if there is an incidental amount of manmade stuff in your scene, 
but your photograph should be all or almost all natural, and the subject should clearly be nature. 
 

 Requirement 2: An Outdoor Night Scene of Architecture 
As in requirement 1, take a night photograph of at least one or two seconds exposure with 
absolutely no motion blur, but this time your subject should be architecture. Example subjects 
include bridges, city streets, buildings, cityscapes, etc. Reminder: your photo should be well 
exposed, so we can see detail in the buildings and other objects -- don't make it so dark that all 
we can see are the lights. 
 

 Requirement 3: HDR Photography 
Take two HDR photographs of two different scenes (only one can be on campus).   
• Carefully select your scene and subject. Bright colors can really pop in HDR.  
• It should have both highlights and shadows.  
• No people, animals, or moving objects - only inanimate objects. 
• One image must have a realistic look and the other should have a creative look. 
• Submission: UPLOAD ALL source and final images to your Picasa account. 
 

 Directions for the HDR Photography Shoot 
1. Using a tripod is essential. 
2. Select an appropriate scene and composition. 
3. Set the camera to 200 ISO, manual mode, and f16. 
4. Focus on the scene and turn the auto focus off. 
5. Find the “normal” exposure according to the light meter, shoot one frame (careful not to 

move the camera / tripod). 
6. Next, shoot one full stop below (-1 stop) the normal exposure (three clicks of the 

dial).  Shoot another at -2. 
7. Finally, shoot one full stop above (+1 stop) the normal exposure and another at +2.  
8. Take a few different compositions of the same scene. 
9. We will practice processing these in Photoshop on Thursday. 

 
Upload your photos and add comments. 

 
Upload your photos using the Picasa account you created in the first assignment to a public Picasa 
album titled "RTV2773 Assignment 6 - Night and Color". Write at least two short paragraphs (i.e., 
two Picasa comments) below each of your photos explaining how you arranged the scene, how you 
took the photo, and what relevant camera settings you used and why, any image processing done 
to the photograph afterwards, and most importantly, which requirement the photo covers. 

. 


